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1. Introduction

11. Introduction

The web based application will facilitate the Ministry of Rural Development (MoRD) to closely
monitor the utilization of funds allocated for NSAP (National Social Assistance Program). The
users at different level will be able to maintain Pensioner Details, estimate budget for pension,
allocate funds for disbursement of pension, maintain pension disbursement details, capture
verification information of pensioners and generate reports as per the role assigned to them.

The objective of the system is to ensure that the Old Age Pension is received by all the
beneficiaries. The Allocation of Funds and its utilization by the states is available on the web
site.

1.2. Purpose

The purpose of this document is to provide an interface between the user and the NSAP
application. It will help the users understand the several features of NSAP application viz.
DATAENTRY — /modification, report generation, queries and various modules of the
application.

1.3. Scope

The web based application will facilitate the Ministry of Rural Development (MoRD) to closely
monitor the utilization of funds allocated for NSAP (National Social Assistance Program). The
users at different level will be able to maintain Pensioner Details, estimate budget for pension,
allocate funds for disbursement of pension, maintain pension disbursement details, capture
verification information of pensioners and generate reports as per the role assigned to them.
The objective of the system is to ensure that the Old Age Pension is received by all the
beneficiaries

1.4. Target Audience

The expected users of this document are Ministry of Rural Development., State Nodal Agencies,
District Level Agencies, Sub-District level agencies and Gram Panchayat/\WWard who will use this
system, NIC Project Coordinators and the development team who will develop the application.

1.5. Organizational Hierarchy

Following is the organizational hierarchy of various agencies involved in NSAP (National Social
Assistance Program).
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1.6. Hardware Requirements

The following are the minimum hardware required to operate application.

Application Server

Database Server

1.7. System Software Requirements

Application Server
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Dual Intel XEON quadcore @ 2.13 GHz
or above physical processors

8 GB RAM or above (upgradable to 16
GB RAM)

3 X146 GB SATAHDD

2 X Dual Port 10/100/1000 Ethernet
Adatpter

OS Support: Windows & Linux

Dual Intel XEON quadcore @ 2.93 GHz
or above physical processors

8 GB RAM or above (upgradable to 32
GB RAM)

3 X 300 GB SATAHDD

2 X Dual Port 10/100/1000 Ethernet
Adatpter

2 X HBA Card

OS Support: Windows & Linux

OS : Linux
JDK 1.6
Jboss 4.2.3

DB Driver: postgresql-8.3-603.jdbc4
1T
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DB Server = OS: Linux (Latest Version)

= DB: Postgre 8.2.5

Client side = Recommended internet explorer 5.0 or
above or mozilla fire fox or netscape
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2. Product Perspective

2.1. Product functionalities:

The system will provide the following functionalities:

. Fund requirement estimation

o Fund Allocation

o Identification of Pensioner

o Process Appeals

o Sanction of Pension

o Disbursement of Pension

o Verification of Pensioner

. Discontinuation of Pension

o Legacy Data Management

o Master Data Management

o User Management

o Access Control Management
2.2 System Interfaces

The Proposed system will take inputs from BPL database. The BPL database will provide the
list of persons included in the BPL list, which will be used for verifying the BPL status of the
applicant. The existing pensioners, not in BPL shall continue to receive pension.

The Proposed application will generate inputs for Banks for Disbursement of Pension. The
details will include Pensioner Name, Pensioner A/IC No. and Amount to be deposited. The
Bank will return the Transfer statement, which will be captured in the proposed system to
record the disbursement.

The Proposed System will generate inputs for Post Offices for Disbursement of Pension. In
case Pensioners have Savings A/C in PO then the details will include Pensioner Name,
Pensioner A/C No. and Amount to be deposited.

If the Pension is to be sent through Money Order then the details will include the Pensioner
Name, Pensioner Address and Amount. The Post Office will return the Transfer statement/
Money Order receipts, which will be captured in the proposed system to record the
disbursement

2.3. Operations

a) User-initiated operations

The system will have user-initiated operations. Based on the choice/link clicked by the user
the system will display the requisite information or prompt for required input.
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b) Batch Data Upload operations

At times bulk data might be received at central location which will be uploaded into the system
after proper verification and validation.

c) Batch Programs

The Proposed system will have programs which will run unattended as per schedule. These
programs will do batch processing of data.

d) Backup and recovery operations.
Regular backups will be taken of the entire system

2.4. User Characteristics

The user should be familiar with the working on a web site using a browser like navigating
though links, searching for required information.

Users who handle transactions should be familiar with the procedures of NSAP

2.5. General Constraints

The lower level establishments like Block and Gram Panchayat offices are in remote areas
where network connectivity is not available. In such cases, the system may not be
accessible online. The user may have to visit the nearest office where such facility is
available to work on the system.

. Alternatively, the user can maintain the required information on local PC in pre-defined
formats. They can upload files periodically from the nearest internet facility within the district.

Facility to send CD to district HQ and upload it from district HQ.

2.6. Modules

The proposed application will provide the following functionalities:

Fund requirement Estimation

This module will allow the establishments at lower levels to consolidate their budgetary
requirements of funds for disbursement of pension and request allocation of funds from the next
higher level in the chain. The users of the lower level offices like Block and Municipal offices will
estimate their budgetary requirement based on the no. of pensioners in their area and send it to
their respective district authorities. The district authorities will consolidate the requirements from
lower offices and send it to the State Nodal Agency. The State Nodal agency will consolidate the
requirements from all the districts and forward it to the Ministry of Rural Development. The
Ministry will consolidate the requirements from the states and request funds for disbursement
from Ministry of Finance.

Fund Allocation

This module will allow the establishment to allocate funds to lowers establishments for further
disbursement. When Ministry receives the funds, it enters the amount received and allocates
the fund to the State Nodal Agencies. The State Nodal Agencies in turn allocate the fund to
District Level Agencies. The District Level Agencies allocate funds to Sub-district/ Municipal
area Offices for further disbursement
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Identification of Pensioner

This module will allow processing the applications submitted by fresh applicant for sanction of
pension. The applicant information will be captured into the online system along with the
necessary documentary evidence details. The application will be verified and approved / rejected
on line in the proposed system.

Process Appeals

This module will allow handling appeals, which are submitted by applicant (for re-considering the
application) and pensioners (for re-instantiation of Pension in case of discontinuation). The
appeal will be put up to the Appeal Hearing authority for comments online.

Sanction of Pensioner

This module will allow the Sanctioning authority to sanction the pension. The Sanction Order
Issuing authority will generate the sanction order/pension payment order

Disbursement of Pension

This module will handle the disbursement of Pension. The user will be able to generate list of
pensioners along with Pension due to them. It will also generate reports showing amount that
need to be transferred to respective Banks and Post offices for disbursement of Pension. It will
also compute cash to be allocated to the individual(s) disbursing pension in cash in their Sub-
District / Municipal Area. The user will be able to capture the disbursement made to the
respective pensioners based on the transaction statements received from bank, money order
receipts and cash receipts.

Verification of Pensioner

This module will allow capturing the current status of the pensioner in terms of
availability/migration, eligible/non-eligible, alive/dead details.

Discontinuation of Pension

This module will allow the designated user to discontinue pension for cases reported for
discontinuation during verification.

Legacy Data Management

This module will help in uploading the legacy data in to the system. If the states already have
pensioner’s details in digital format, they can be uploaded through batch upload process.
Records satisfying the pre-requisites will be uploaded in the system. If the states do not have
data in digital form, an online entry screen will be provided to key-in existing pensioner details.

Master Data Management

This module will help in maintaining the master data which will be required for functioning of the
transaction modules. This includes master table for Ministry, State, District, Sub-District /
Municipal Area, Gram Panchayat/Ward, Village, Habitation, Bank, Post Office, Criteria, Pension
Amount, Category, Status, Parliament Constituency, Legislative Assembly Constituency,
Scheme and Disability.

User Management

This module will take care of user creation, modification and deletion. All the users who will
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handle transactions will be given a login id and a password by the State administrator.

The System will maintain the audit trail of all the transactions made in the system.

Product Actors and Functions

This section defines the stakeholders at different levels in the hierarchy and actions performed
by them in the system.

Ministry Level

Main Use Cases

Fund

Requirement

Estimation

Fund Allocation

Legacy

Data

Management

Master

Data

Management

Primary Actors

MoRD

MoRD
MoRD

Data
Operator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator
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Entry

Sub Use Cases

Fund Requirement Estimation for
Ministry

Allocate Fund to Ministry
Allocate Fund to States

Enter Pensioner Data

Upload Pensioner Data

Verify Uploaded Pensioner data

Maintain Ministry Master

Maintain State Master

Maintain District Master

Maintain Sub-District / Municipal

Area Master

Maintain Gram Panchayat/Ward
Master

Maintain Village Master

Maintain Habitation Master

Maintain Bank Master

Maintain Post Office Master
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User Management

Access Control

State Level

Main Use Cases

Fund
Estimation

Requirement

Fund Allocation

Identification of Pensioner

v NS AR NIC. indog inT SAF User Manual werd him

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

System
Administrator

Primary Actors

Maintain Criteria Master

Maintain Pension Amount Master

Maintain Category Master
Maintain Status Master
Maintain

Constituency Master

Maintain  Legislative
Constituency Master
Maintain Scheme Master

Maintain Disability Master

Maintain User

Maintain Roles

Assign Roles

Sub Use Cases

State Authority Fund Requirement Estimation
State

State Authority Allocate Fund to Districts

Application Add Application

Receiver

Application Modify/Delete Application

Receiver

Verifying Verify Application

Authority

SO Issuing Transfer Sanction Order

Authority
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SO Issuing Accept Transferred SO
Authority
Disbursement of Pension  Disbursing Compute  Pension Payable to
Authority pensioner
Process Appeals Appeal Hearing Approve Appeal
Authority
Verification of Pensioner Verifying Enter Verification Report
Authority
Discontinuation of Pension Disbursing Discontinue Pension
Authority
Master Data Management  System Maintain Gram Panchayat/ Municipal
Administrator Ward Master
System Maintain Village Master

Administrator

System Maintain Habitation Master
Administrator

System Maintain Bank Master
Administrator

System Maintain Post Office Master
Administrator

User Management System Maintain User
Administrator

Access Control System Assign Roles
Administrator

District Level

Main Use Cases Primary Actors Sub Use Cases
Fund Requirement District Fund Requirement Estimation for District
Estimation Authority
Identification of Application Add Application
Pensioner Receiver
Application Modify/Delete Application
Receiver
Verifying Verify Application
Authority
Process Appeals Appeal Hearing Approve Appeal
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Authority

District
Authority

Sanction of Pension

SO Issuing

Authority

SO Issuing

Authority

SO Issuing

Authority

Disbursement of Disbursing
Pension Authority

Disbursing
Authority

Verification of Verifying
Pensioner Authority

Discontinuation of Disbursing
Pension Authority

Disbursing
Authority

Legacy Data Data Entry

Management Operator

System

Administrator

System
Administrator

Master Data System
Management

System

Administrator

System

Administrator

System

Administrator

System

Administrator

System

Administrator
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Sanction of Pension

Edit Mode of Payment/ PDA

Transfer Sanction Order

Accept Transferred SO

Compute Pension Payable to pensioner

Print Pension Payable Statement

Enter Verification Report

Discontinue Pension

Re-instate Pension

Enter Pensioner Data

Upload Pensioner Data

Verify Uploaded Pensioner data

Maintain Sub-District / Municipal Area Master

Maintain Gram Panchayat/Ward Area Master

Maintain Village Master

Maintain Habitation Master

Maintain Bank Master

Maintain Post Office Master
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User Management System Maintain User

Administrator

Sub-District / Municipal Area Level — (Municipal/Block/Mandal/T ehsil)

Main Use Cases Primary Actors
Fund Requirement Sub-District / Municipal
Estimation Area Authority

Identification of Pensioner Application Receiver

Application Receiver
Verifying Authority
Process Appeal Application Receiver
Appeal Hearing Authority
Sanction of Pension Sanctioning Authority
SO Issuing Authority
SO Issuing Authority
SO Issuing Authority
SO Issuing Authority

Disbursement of Pension  Disbursing Authority

Disbursing Authority

Disbursing Authority
Disbursing Authority
Verification of Pensioner  Verifying Authority

Discontinuation of Disbursing Authority
Pension

Sub-District / Municipal
Area Authority

Legacy Data Data Entry Operator
Management

System Administrator

System Administrator
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Sub Use Cases

Fund Requirement Estimation
for Sub-District / Municipal Area

Add Application

Modify/Delete Application
Verify Application

Register Appeal

Approve Appeal

Sanction of Pension

Issue Sanction order

Edit Mode of Payment/ PDA
Transfer Sanction Order
Accept Transferred SO

Compute Pension Payable to
Pensioner

Print Pension Payable
Statement

Transfer Fund
Update Disbursement Ledger
Enter Verification Report

Discontinue Pension

Re-Instantiate Pension

Enter Pensioner Data

Upload Pensioner Data

Verify Uploaded Pensioner data
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All Actors
S.No. Main Use Cases Primary Actors
1 Common Use Cases  All Actors
All Actors
All Actors
All Actors

3. Change Scheme and Language

Use Case Sub Use Cases

No.

13.1
13.2
13.3

13.4

When the user logs in, the following screen will be available.
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Here two dropdowns are available Select Language and Select Scheme.

3.1. Change Language

User can change the language from select language dropdown. If user selects Hindi the fonts are
changed to Hindi
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3.2. Change Scheme

User can change the scheme from select scheme dropdown. Here three options are available to the
user :-IGNOAPS, IGNDPS, IGNWPS where

IGNOPAS - Indira Gandhi National Old Age Pension Scheme
IGNDPS - Indira Gandhi National Disability Pension Scheme

IGNWPS - Indira Gandhi National Widow Pension Scheme
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Here user can change the scheme by selecting it from dropdown. The forms will change according to
the selected scheme.

The schemes available to the User will be assigned by the corresponding ADMIN.

Home

4. ldentification of Pensioners

This module allows the user to submit fresh applicant for sanction of pension. The application
will be verified or returned (rejected) .

4.1. Enter New Application - IGNOAPS

User clicks on Identification -> New ->Add link .
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User enters the details in the application form shown above. Fields marked in red are mandatory
fields. The application is submitted to the verification officer at different levels depending upon the
levels of verification specified in state master. Once verified the application cannot be modified. Age of
the pensioner should not be less then 65 years.
4.1.1. Save
On the click of save the application details will be saved and a confirmation message is
displayed along with application number
4.1.2. Submit
On the click of submit the application details will be saved and forwarded for verification to
Verifying Authority. Application Number generated will be displayed.

4.1.3. Reset
On the click of Reset the application form will be reset to its original state.

4.1.4. Cancel
On the click of cancel the application details will not be saved and the form will be closed.

4.2, Enter New Application - IGNWPS

User clicks on Identification -> New ->Add link .
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User enters the details in the application form shown above. Fields marked in red are mandatory
fields. The application is submitted to the verification officer at different levels depending upon the
levels of verification specified in state master. Once verified the application cannot be modified. Age of
the pensioner should be between 40 and 65 years.
4.21. Save
On the click of save the application details will be saved and a confirmation message is
displayed along with application number
4.2.2. Submit
On the click of submit the application details will be saved and forwarded for verification to
Verifying Authority. Application Number generated will be displayed.

4.2.3. Reset
On the click of Reset the application form will be reset to its original state.

4.2.4. Cancel
On the click of cancel the application details will not be saved and the form will be closed.

4.3. Enter New Application - IGNDPS

User clicks on Identification -> New ->Add link .
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User enters the details in the application form shown above. Fields marked in red are mandatory
fields. The application is submitted to the verification officer at different levels depending upon the
levels of verification specified in state master. Once verified the application cannot be modified. Age of
the pensioner should be less then 65 years and pensioner should have atleast 80% disability in case
of single disability and in case of multiple disabilities, disability percent aggregate should be atleast
80%.
4.31. Save
On the click of save the application details will be saved and a confirmation message is
displayed along with application number
4.3.2. Submit

On the click of submit the application details will be saved and forwarded for verification to
Verifying Authority. Application Number generated will be displayed.

4.3.3. Reset
On the click of Reset the application form will be reset to its original state.

4.3.4. Cancel
On the click of cancel the application details will not be saved and the form will be closed.

4.4. Modify/View Application
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Click on the identification-> application for pension->Modify

Modify/View Apj uﬁﬁm

This form enables the user to modify the existing application. To modify the application, the
user has to search the application by entering the details in form shown above. User can search
either on basis of Application Number or Applicant Name.

4.41. Search

The user has to enter search criteria. Fields marked in red are mandatory. User can search
either on basis of Application Number or Applicant Name. The records satisfying the search
criteria will be displayed in a grid with view and modify option as shown below.

4.4.2. Cancel
On the click of the cancel button the form will be closed.

4.4.3. Modify

On the click of the Modify button the application details will be displayed as shown below in
editable mode.
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| Cerificates

4.4.4. Save

On the click of save the application details will be saved and a confirmation message is
displayed.

4.4.5. Submit

On the click of submit the application details will be saved and forwarded for verification to
Verifying Authority.

4.4.6. Cancel

On the click of cancel the application details will not be saved and the form will be
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closed.

4.5. View Application

On the click of the view button the user can view the application details in non-editable

mode.

4.5.1. Print
On the click of print the application shown above will be printed.

4.5.2. Back
On the click of Back, the form will be closed.

Home

5. Verification of Application

The application can be verified at different levels — Level 1, Level 2 and Level 3 depending upon the
level of verification specified in State Master.

When the verification officer logs in, the applications submitted to the officer are displayed in the grid
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as shown below.

Click on verification>application pending for verifier 1

.F':nal Level Verification
Application Applicant Husband/Father

Nimber Nenic Nariia Application Status  Verified Rxm:mdnugﬁm Remarks
HR-A00000199 g e el NEW

HR-A-00000299 goft T MEW

HE-A-00000392 e bics NEW °

HRAD00G04588 A | NEW @

HR-ADD0O0593 Ao SEEE g NEW @

HR-AD0000698  gden TH T NEW @

HR-A00000798° & T NEW °

HE-AD0000893  Ram IO NEW 9

HR-A-B0080699 e B w1t T MEW ]

| Submit || Cancel |

The
verification officer can select either verify, return or no action.

5.1. \Verify

If the verification officer selects verify, and if the user is First/Second level Approver, the application is
forwarded to next level for verification, The application status is ‘Verified — Level I' if verified by Level |
authority or Verified — Level —II' if verified by level Il authority.

If verified, if the user is Final level Approver, the application is forwarded to Sanctioning Authority for
Sanction of Pension. If Verifying Authority is at level | only, then level Il and level lll is skipped and
application is forwarded to Sanction Authority for sanction. If Verifying Authority is at level Il only, then
level Il is skipped and application is forwarded to Sanction Authority for sanction. If Verifying Authority
is at level lll authority or the final authority, then application is forwarded to the Sanctioning authority for
sanction.

5.2 Returned

If Returned is selected, the application is rejected and the application can be modified by the applicant
and resubmitted for verification. The application status is ‘Rejected’. The applicant is intimated
rejection of application along with Reason for rejection.

5.3. No Action

No action keeps the application on hold, it can be returned or verified later and will continue to display
in the list.
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On the click of the application number the application details can be viewed as shown below:

6. Sanction of Pension

The verified pension applications are submitted for Sanctioning.

6.1. Application Pending for Sanction

Click on sanction> Application Pending for Sanction

When the sanction officer logs in, the following form is displayed to search for the applications
pending for sanction.

The search criterion has to be entered. The fields marked in red are mandatory.
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6.1.1.

o o

On the click of search, the following form is displayed with list of applications pending for sanction. On
the click of Application number, the application details can be viewed in non-editable mode as shown
below.
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To sanction the application, the user needs to select the respective application, and the details.

6.1.2. Submit

On the click of submit, the selected applications are sanctioned and are taken ahead for issue of
Sanction order.

6.1.3. Cancel

On the click of cancel the form is closed.

6.2. Issue Sanction Order

The applications already sanctioned will be available for issuing sanction order.

Click on sanction>Issue Sanction Order

The user can select the application and issue sanction order. On the click of the application number,
the application details will be shown in non-editable mode.

6.2.1. Cancel

Click on cancel will close the form.

6.2.2. Generate SO

After selecting the desired application, click on this button will issue sanction order.
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The user needs to select the Pension Disbursement Mode.

If the mode of disbursement is Bank A/C, user selects Bank Name, Branch name, Branch and
enters A/C No.
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- If mode of disbursement is Cash, user selects Cash Disbursing Authority.

Mode OFf Payment: CASH
Cash Disbursement Authority: Select PDA- ]
PDA;

| Save ! Cance| !

System displays the pension disbursement details accordingly.

6.2.3. Save

Click on save, after entering all the details will issue the sanction order.

6.2.4. Cancel

Click on cancel will close the form and cancel the operation.

6.3. Modify Pension Disbursement Authority (PDA)

The Pension Disbursement Authority can be modified through this form. The user needs to search for
the application.

Click on Sanction>Modify PDA

Modify PDA

State®  HARYANA |~ | District* --Select District— | =] Area * -Select Area| = |
Sub DistrictiMunicipal Area *  -Select- = Gram PanchayatWard ©  -Select = |
Village Salect Village-|» | Habitation Select Habitaion- = |

Sanction Order No,'

The fields marked in red are mandatory.

6.3.1. Cancel

On click of cancel, the form is closed and operation is cancelled.

6.3.2. Search

On click of search, the record is displayed as per search criterion as shown below
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In the above form the mode of disbursement is Post office account. The details are displayed
depending upon the mode of disbursement already explained in section 5.2.2 above.

6.3.3. Save

On click of save the PDA will be modified accordingly.

6.3.4. Cancel

On click of Cancel the operation is cancelled and form is closed.

6.3.5. Print

On click of Print, the details can be printed.
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6.4. Print Sanction Order

The sanction order can be printed here. The user needs to search for the required sanction order by
entering the search criterion.

Click on Sanction> Print Sanction Order, to reach the following form.

Fields marked in red are mandatory.

6.4.1. Cancel

On click of cancel the operation is cancelled and form is closed.

6.4.2. Search

The sanction order will be displayed as per the search criterion. On Click of application number the
application details are visible in non-editable mode.
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6.4.3. Print

On click of Print, the sanction order will be printed.
6.4.4. Close

On click of Close, the form will be closed.

6.5. Transfer Sanction Order

Sanction order can be transferred through this form. The user needs to search for the required
sanction order by entering the search criterion.

Click on the sanction>Transfer Sanction Order

6.5.1. Cancel

On the click of cancel the form is closed.

6.5.2. Submit
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On the click of submit, form will appear related to the sanction order number on the screen in which
details regarding the transfer of sanction order needs to be filled in by the user.

6.5.3. Cancel

On the click of cancel operation is canceled and the form is closed.

6.5.4. Save

On the click on the save, the form will be saved and following message will display on the screen.

6.6. Accept Transfer Order

When the user logs in, the applications submitted to the user are displayed in the grid as shown
below. User will select the application and then click on submit.

Click on the Sanction>Accept Transfer Order

6.6.1. Cancel

On the click of cancel, operation is cancelled and the form is closed
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6.6.2. Submit

On the click of submit, form will be displayed on the screen. This form will contain the information
regarding place from the sanction order is being transferred and to the place where sanction order is
being transferred. User will be asked to fill in the mode of disbursement.

User will enter all the details in the form and click on the any of the three options given at the end of
the form
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> Accept

On the click of the accept, sanction order will be accepted by the user and following message will be
displayed “sanction order accepted successfully”

> Reject

On the click of the reject, operation will cancelled and the form will be closed and “Sanction Order
Rejected” will be displayed on the screen.

» Cancel
On the click of cancel, operation is cancelled and the form is closed

Home
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7. Disbursement of Pension

7.1. Compute Pension Payable to Pensioner

User can compute pension payable through this form. User needs to fill in all the details in this form
and will also give the date upto which pension needs to be calculated.

Click on Disbursement>Compute Pension Payable to Pensioners

Compute Pension Payable to Pensioner

State Hﬁﬂ-“fﬁ.NAB District * ~Select Distnct-- L—I Area " | Select Area E!
Sub DistrictMunicipal Area *  --Select- E| Gram Panchayat\Ward --Galﬂci--a
Pension Amount Payable Up To® Select E Selemz
i Submit | | Cancel |
7.1.1. Cancel

On the click of cancel, the operation is canceled and the form is closed

7.1.2. Submit

On the click of submit, following information will be displayed. In front of each applicant amount due to
that applicant will be displayed. And total amount due to all the applicants will also be displayed.
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71.21. Compute

On the click of the compute, “pension computed successfully” will be displayed.

7.1.2.2. Cancel

On the click of cancel, the operation is cancelled and the form is closed.

7.2. Print Pension Payable

User can transfer the funds by entering all the details of the following form. There should be some
amount released to available with the sub district for disbursement, so that sub district can transfer
the requisite amount to PDA.

Click on Disbursement>Print Payable
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Print Pension Payment Statement
!-'_!  District —Sﬂmﬂwf-
e

ng

I_...

7.2.1. Cancel

On the click of cancel, the operation is cancelled and the form is closed.

7.2.2. Submit

On the click of submit, all the information regarding the applicants will be displayed. Now officer can
print the information according to his use.

Futtpe v, resagnic.inSogin®™ SAPH20U s er ¥ 200 anusl %20ver 3 him 4570



Frttpe v resagonic inSog in® SAPMA0L s er 36 200 anual %20ver 3 film




A252015 wawhelngap nic.indog intSAP Usar Manual ver 3 him

7.3. Transfer Funds

Click on Disbursement> Transfer Funds

The user needs to select the Pension Disbursement Mode.

7.3.1. If mode of disbursement is Cash

Another form will be displayed on the screen. Users will then select cash disbursing authority and fill
all details in the form. [One important point to note is pension payable should be computed in the
advance and amount to be  transferred should also be computed in advance]
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7.3.1.1.  Submit

On the click of submit, “Amount has been successfully transferred” will be displayed on the screen.
The voucher number is =========s=nu-- .” will be displayed on the screen.

7.3.1.2. Cancel

On the click of cancel, the operation is cancelled and the form is closed.

7.3.2. If the mode of disbursement is Bank A/IC

Another form will be displayed on the screen. Users will then select Bank disbursing authority and fill
all details in the form. [One important point to note is pension payable should be computed in the
advance and amount to be transferred should also be computed in advance]
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Transfer Fund
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7.3.21.  Submit

On the click of submit, message “Amount has been successfully transferred” will be displayed on the
screen. The voucher no. is .’will be displayed on the screen.

7.3.2.2. Cancel

On the click of cancel, the operation is cancelled and the form is closed.

7.3.3. If mode of disbursement is post office

Another form will be displayed on the screen. Users will then select post office disbursing authority
and fill all details in the form. [One important point to note is pension payable should be computed in
the advance and amount to be transferred should also be computed in advance]
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7.3.3.1.  Submit

On the click of submit, message “Amount has been successfully transferred” will be displayed on the
screen. The voucher no. ig-----==-==--- .”will be displayed on the screen.

7.3.3.2. Cancel

On the click of cancel, the operation is cancelled and the form is closed.

7.3.4. If mode of disbursement is Money Order

Another form will be displayed on the screen. Users will then select Post Office disbursing authority
and fill all details in the form. [One important point to note is pension payable should be computed in
the advance and amount to be transferred should also be computed in advance]
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Pension should be computed in the advance and amount to be transferred should also be computed
in advance. User enters the details in the application form shown above.

7.3.41.  Submit

On the click of submit, message “Amount has been successfully transferred” and The voucher
number is -------=------- . will be displayed.

7.3.4.2. Cancel

On the click of cancel, the operation is cancelled and the form is closed.

7.3.5. Update ledger

User can update the ledger through this form. After PDAs gives the confirmation of the transfer of
funds, user can update the ledger regarding the same.

Disbursement >Update Disbursement Ledger

User will enter the details of the following form. User will enter the amount paid to the user and has to
select the applicant of whom he wants to submit the details entered by user.
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7.3.5.1.  Submit

On the click of submit, “Records Updated successfully” will be displayed.

7.3.5.2. Cancel
On the click of cancel, the operation is cancelled and the form is closed

Home
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8. Estimation of Required Funds

This module allows the user to estimate the funds required by the MORD, states, districts, sub
districts and Gram Panchayat.

8.1. Fund Requirement Estimation- Sub District levell Municipal Area Level

The User can estimate amount required for disbursement of pension in the Sub-District / Municipal
Area. User selects the year for which the estimation has to be made. User selects the period From
Month and To Month for which the estimation has to be made. No. of existing pensioners will be

shown in the text box. User may enter the number of estimated new pensioners if required.

User clicks on Sub District Level/Municipal Area Level ->Add :The following screen will be
displayed. Here user can add new estimation for a particular period.

Fund Requirement Estimation . Sub.DistrictMunicipai Area Level

Sub-DistnctMunicipal Arsa BCHHNERS
Finzncial Yaar 2008 820100

Frem Month Jul s Wi Manth | Jul o
ho. of Exiglmg Penslonars 0

Ho. of Estimiated Mew Pansmoners {1000

Total Estimated Fensioners {1009

Estimated Pension Amount | 300000
Remadis
P ACHHMNERA T :
[ Se J | Sabivl ” Cance

The information submitted here will be available as aggregrate of all the sub districts to the districts.
8.1.1. Save

If user clicks on save the estimation will be saved and can be modified later.

8.1.2. Submit

If user clicks on submit the estimation will be saved and forwarded but cannot be modified later.

8.1.3. Cancel
If user clicks on cancel the form will be closed.

User clicks on Sub District Level/Municipal Area Level ->Modify :The following screen will be
displayed. Here user can modify a saved estimate or view an estimation for a particular period.

Sub-DistrictMunicipal

Fund Requirement Estimation - Sub.District'Municipal Area Lavel Area:ACHHNERA

- Tatal Estimatad ; ’
Period From Period To fe s Estimated Pension dmiount

Jul-2008 Jul-2009 G 1800 [dodiby Yigw
Back
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If user can clicks on View the following screen will be displayed

8.2. Fund Requirement Estimation- District level/ Municipal Area Level

User clicks on District levell Municipal Area Level ->Add the following screen will be
displayed.
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8.2.1. Save

If user clicks on save the estimation will be saved and can be modified later.

8.2.2. Submit

If user clicks on submit the estimation will be saved and forwarded to state level estimation and
cannot be modified later.

8.2.3. Cancel

If user clicks on cancel the form will be closed.

Use clicks on Estimation->District->Modify->The following screen will be displayed. Here user
can modify a saved estimate or view an estimation for a particular period.

If the user clicks on view the following screen will be displayed.
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If the user clicks on Modify the following screen will be displayed

8.3. Fund Requirement Estimation- State Level

User clicks on State Level ->Add the following screen will be displayed.

NODAL OFFICER _ 012
Sl Subms. | Canca

8.3.1. Save
If user clicks on save the estimation will be saved and can be modified later.

8.3.2. Submit

If user clicks on submit the estimation will be saved and forwarded to state level estimation and
cannot be modified later.
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8.3.3. Cancel

If user clicks on cancel the form will be closed.

Use clicks on Estimation->State->Modify->The following screen will be displayed. Here user
can modify a saved estimate or view an estimation for a particular period.

| f user clicks on Modify the following screen will be displayed

Fund Ragiresiis

B N

» Save:-f user clicks on save the estimation will be saved and can be modified later.
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> Submit :- If user clicks on submit the estimation will be saved and forwarded to state level
estimation and cannot be modified later.

» Cancel:- If user clicks on cancel the form will be closed.

8.4. Fund Requirement Estimation- Ministry Level
8.4.1. Add Link

User clicks on Estimation->Ministry Level ->Add the following screen will be displayed.
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> Save:-

If user clicks on save the estimation will be saved and can be modified later
> Submit :-

If user clicks on submit the estimation will be saved and forwarded to state level estimation and
cannot be modified later.

» Cancel:-

If user clicks on cancel the form will be closed.

8.4.2. Modify Link

User clicks on Estimation->Ministry->Modify :-The following screen will be

displayed .It will show all the estimates done at state level

If the user clicks on Modify the following screen will be displayed

Frttpe v resagonic inSog in® SAPMA0L s er 36 200 anual %20ver 3 film 5479



A252015 wawhelngap nic.indog intSAP Usar Manual ver 3 him

> Save:-f user clicks on save the estimation will be saved and can be modified later.

> Submit :- If user clicks on submit the estimation will be saved and forwarded to state level
estimation and cannot be modified later.

» Cancel:- If user clicks on cancel the form will be closed.
8.4.3. Viewlink

If the user clicks on View the following screen will be displayed
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9. Fund Allocation and Release

This module allows the user to allocate and release the funds.

9.1. Ministry Allocation

User clicks on Allocation ->Ministry ->allocation The following screen will be displayed

9.1.1. Submit

If User clicks on submit funds will be allocated to states .

9.1.2. Cancel

If user clicks on cancel the form will be closed
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9.2. State Allocation and Release
9.2.1. State Allocation

If user clicks on Allocation->State Allocation the following screen will be displayed

when user selects year the following screen is displayed
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._______._____,________

9.2.1.1.  Submit
If User clicks on submit the allocation will be submitted for the selected financial year .
9.21.2. Cancel

If user clicks on cancel the form will be closed
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9.2.2. State Release

User Clicks on Allocation->State Release The following screen is displayed

9.2.21. Cancel
If user clicks on cancel the form will be closed

If user selects year the following screen is displayed
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9.2.2.2. Submit

If user clicks on the amount will be allocated and will be available to districts for allocation.

9.2.2.3. Cancel

If user clicks on cancel the form will be closed

9.2.3. Release Funds by State Finance
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9.2.3.1.  Submit

On the click of submit, “Fund Released successfully” will be displayed on the screen.
9.2.3.2. Cancel

On click of cancel, the form is closed and operation is cancelled.

9.3. District Allocation and Release

User [state user] can allocate the funds to the district by entering the details in the following form.
User will be asked be asked to enter the state name and date.

9.3.1. District Allocation

When user enters the year, automatically another form will be displayed on the screen. User can
allocate the funds to the district by entering the details in the following form.
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9.3.1.1.  Submit

On the click of submit, “Fund Allocation Completed successfully” will be displayed on
the screen.

9.3.1.2. Cancel

On click of cancel, the form is closed and operation is cancelled.

9.3.2. District Release

User [district user] can release the funds to the District by entering the details in the following forms.
User will enter the year and state name in their respective column.
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When user enters the details, system will display the worksheet for capturing the amount allocated to
the districts. User will fill in all the details and give remarks at the end.

BIER R

BB ER

#®

|BrE B B® EBBCE A

9.3.21. Submit

On the click of submit, “Fund released successfully” will be displayed on the screen.
9.3.2.2. Cancel
On click of cancel, the form is closed and operation is cancelled.
9.4. Sub-District Allocation and Release

User [district user] can allocate the funds to the district by entering the details in the following form.
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User will be asked to enter the state name, district, area and date.

9.4.1. Sub-District Allocation

When user enters the details, system will display the worksheet for capturing the amount allocated to
the sub districts. User will fill in all the details and give remarks at the end.

‘Fund Allocation to Sub District

| ST | ST

9.4.1.1. Submit

On the click of submit, “Fund Allocation Completed successfully” will be displayed
on the screen.

9.4.1.2. Cancel

On click of cancel, the form is closed and operation is cancelled.

9.4.2. Sub-District Release

User [sub district user] can release the funds to the sub district by entering the details in the following
forms. User will be asked to enter the state name, district, area and date.

Allocation>Sub-District Release
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When user enters the details, system will automatically display the worksheet for capturing the
amount allocated to the sub districts. User will fill in all the details in the following form.

T,

nd Allocation to Sub Distri

9.4.21. Submit

On the click of submit, “Fund Allocation Completed Successfully” will be displayed
on the screen.

9.4.2.2. Cancel
On click of cancel, the form is closed and operation is cancelled.

Home

10. Discontinue Pension
10.1. New Appeal

This form allows the user to submit the new appeal. User needs to enter all the details in this form.

Click on the Discontinue>New Appeal

10.1.1. Cancel
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On the click of cancel, the operation is cancelled and the form is closed
10.1.2. Submit

On the click of submit following information will be displayed

Appeal For Discontinuation of Pension

L a h —_— e spEe=ssaedOnrs
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10.1.2.1. Cancel

On the click of cancel, the operation is cancelled and the form is closed.

10.1.2.2. Submit

On the click of submit information will be submitted.

10.2. Pending Appeals
This information will allow user to see the applications which are pending

Click on the Discontinue> Pending Appeals

Appeals Pending For Approval
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If the user clicks on hyper linked appeal number the following page will be displayed

10.2.1. Submit

If the user clicks on submit his approved or rejected appeal will be submitted.

10.2.2. Cancel

If user clicks on cancel form will be closed.

10.3. Discontinue Pension

This form allows the user to discontinue the pension for the cases reported. User needs to enter all
the details in this form.

Click on the Discontinue>Discontinue
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10.3.1. Cancel

On click of cancel, the form is closed and operation is cancelled.

10.3.2. Submit

On click of submit, the record is displayed as per search criterion as shown below

_LIGIEIL.E : = _l__|

Name of applicants will be displayed as search criteria. User will enter the details and select the
applicant of whom user wants to discontinue the pension.

10.3.2.1. Submit

On the click of submit, “The Pension has been discontinued For =======--- With Effect From ===----
--” will be displayed on the screen.

10.3.2.2. Cancel
On click of cancel, the form is closed and operation is cancelled.
10.4. Reinstate

This form will allow the user to re-instate pension. User needs to enter all the details in this form.

Click on Discontinue>Reinstate pension
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10.4.1. Cancel

On click of cancel, the form is closed and operation is cancelled.
10.4.2. Search

On click of search, the record is displayed as per search criterion as shown below

Sanction 7. Date of Dlscamiatn. | Reorewel. Dot Effectu Mt Tear of Rl | B
Dt e bbbt o eson ks N Dale mm Remarks Tnstats
PJS. ABC  MIGRATED {42200 WGRATED W g ) i

(0000040 DEF  PERMANENTLY

Submit {{ Cance
Name of applicants will be displayed as search criteria. User will enter the details and select the

applicant of whom user wants to reinstate the pension.

10.4.2.1. Submit

On the click of submit, “The Pension has been Reinstated For ------—=----- ” will be
displayed on the screen.

10.4.2.2. Cancel
On click of cancel, the form is closed and operation is cancelled.

Home

11. Legacy Data

User can enter the old records through this module. User can enter the past records and can also
modify the records if required.

11.1. Application for Pension- Add
User can add old or past applicant details through this form.

Legacy Data > Application for Pension- Add
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Sanictianing Autharly = PAUCHAYAT|  Sanchion Date”

11.1.1. Save

On the click of save the application details will be saved and a confirmation message is
displayed along with application number. This option gives the user a chance to modify the
details later if required.

11.1.2. Submit

On the click of submit the application details will be saved and forwarded for verification to
Verifying Authority. Application Number generated will be displayed.

11.1.3. Reset
On the click of Reset the application form will be reset to its original state.
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11.1.4. Cancel

On the click of cancel the application details will not be saved and the form will be closed.

11.2. Modify

On the click of the Modify button the application details will be displayed as shown below in editable

mode.

Legacy Data > Application for Pension- Modify

Madify View Application

SO TTARAKHAND B Diskit®| ALMORA ™ -
EECRUR DHASIACHHAANA 6 GranPanshayalt | ALISUPYAL =
il AUSUPYA. 8 atatior’ ALISUPYAL v

Search By, | Appication Mumber (7 Apphcant Mame  Eniter the Search Vel FAJESH

I Search Hian;:ei I

This form enables the user to modify the existing application. To modify the application, the
user has to search the application by entering the details in form shown above. User can

search either on basis of Application Number or Applicant Name.

11.2.1. Search

The user has to enter search criteria. Fields marked in red are mandatory. User can search
either on basis of Application Number or Applicant Name. The records satisfying the search

criteria will be displayed in a grid with view and modify option as shown below.

My Wi Application
Stete UTTARAEHAND K Distriet | SLMORS » Area Bisral il
S Distret | BHAISIACHHANA - SRV A =
Village © ALISUPYAL w Habitation’ AL ISP Y AL i
Search By; () ppplcation Mrbar [+ Appicant Hene  Enfer fhis Search Vel | FAJESH

Searnch l Cancel |
mﬁ::im Applicant bamee Hushand Father lame - Applisation Status
UT-A-D0000205  RAJESH HUMAR Rl MLMAR TEMP e

11.2.2. Cancel

On the click of the cancel button the form will be closed.

11.2.2.1. Modify

i

On the click of the Modify button the application details will be displayed as shown below in

editable mode.
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11.2.2.1.1. Save

On the click of save the application details will be saved and a confirmation message is
displayed.

11.2.2.1.2. Submit

On the click of submit the application details will be saved and forwarded for verification to
Verifying Authority.

11.2.2.1.3. Cancel

On the click of cancel the application details will not be saved and the form will be
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closed.

11.2.2.2. View Application

On the click of the view button the user can view the application details in non-editable mode.

11.2.2.2.1. Print
On the click of print the application shown above will be printed.

11.2.2.2.2. Back
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On the click of Back, the form will be closed.

Term
IGNOAPS
MNSAP
MoRD
BPL

DB

Html
SRS
Web Site
S0

PPO
IEEE
RDEMS
SaL
UPS
PDA
G2G
G2C
C2G

0s

Home

Definition

Indira Gandhi National Old Age Pension Scheme
National Social Assistance Program

Ministry of Rural Development

Below Poverty Line

Data Base

Hyper text markup language

Software Requirement Specification

A place on the world wide web

Sanction Order

Pension Payment Order

Institute of Electrical and Electronic Engineers
Relational Database management System
Structured Query Language

Uninterrupted Power Supply

Pension Disbursement Authority

Government to Government

Government to Customer / Citizen
Customer / Citizen to Government

Operating System

Home
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